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1 Foreword

PROFINET, an open industrial Ethernet standard, is especially well-suited for applications that require fast communication
with a high data rate combined with industrial IT functions. PROFINET is real-time capable and uses IT standards like TCP/IP.

STOBER 6th generation drive controllers support PROFINET, a development of the successful PROFIBUS standard. The drive
controllers are tailored for real-time communication of I/0 data and offer the ability to transfer all required data,
parameters and IT functions at the same time.

The fieldbus functionality is integrated into the firmware in the SC6 or SI6 series drive controllers.

The SC6 and SI6 series drive controllers successfully passed the PROFINET as well as PROFIsafe conformance test. There, the
communication interface was tested to ensure the reliability and function of the lower-level communication regardless of
vendor.

The SC6 and SI6 series drive controllers successfully passed the PROFINET as well as PROFIsafe conformance test. There, the
communication interface was tested to ensure the reliability and function of the lower-level communication regardless of
vendor.

1 | Foreword
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2 User information

This documentation assists you with commissioning the STOBER SC6 or SI6 series drive controllers (10 device) in
combination with a higher-level controller (10 controller) using a PROFINET network.

Technical knowledge

Operating your PROFINET network requires having familiarity with PROFINET network technology and the basics of the
associated Siemens SIMATIC automation systems.

Technical requirements

Before you begin operating your PROFINET network, you need to wire the drive controllers and initially check that they are
functioning correctly. To do so, follow the instructions in the manuals for the SC6 and SI6 drive controllers.

2.1 Storage and transfer

As this documentation contains important information for handling the product safely and efficiently, it must be stored in
the immediate vicinity of the product until product disposal and be accessible to qualified personnel at all times.

Also pass on this documentation if the product is transferred or sold to a third party.

2.2 Described product

This documentation is binding for:

SC6 or SI6 series drive controller in conjunction with the DriveControlSuite software (DS6) in V 6.5-D or higher and
associated firmware in V 6.5-D-PN or higher.

2.3 Timeliness

Check whether this document is the latest version of the documentation. We make the latest document versions for our
products available for download on our website:
http://www.stoeber.de/en/downloads/.

2.4 Original language

The original language of this documentation is German; all other language versions are derived from the original language.

2.5 Limitation of liability

This documentation was created taking into account the applicable standards and regulations as well as the current state of
technology.

No warranty or liability claims for damage shall result from failure to comply with the documentation or from use that
deviates from the intended use of the product. This is especially true for damage caused by individual technical
modifications to the product or the project configuration and operation of the product by unqualified personnel.

07/2021 | ID 443039.04
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2.6 Formatting conventions

Orientation guides in the form of signal words, symbols and special text markups are used to emphasize specific
information so that you are able identify it in this documentation quickly.

2.6.1 Display of safety instructions

Safety instructions are identified with the following symbols. They indicate special risks when handling the product and are
accompanied by relevant signal words that express the extent of the risk. Furthermore, useful tips and recommendations
for efficient, error-free operation are specially highlighted.

ATTENTION!
Attention
This indicates that damage to property may occur

= if the stated precautionary measures are not taken.

A\ cauTion!

Caution

This word with a warning triangle indicates that minor personal injury may occur

= if the stated precautionary measures are not taken.

/A WARNING!

Warning

This word with a warning triangle means there may be a considerable risk of fatal injury

= if the stated precautionary measures are not taken.

A DANGER!

Danger

This word with a warning triangle indicates that there is a considerable risk of fatal injury

= if the stated precautionary measures are not taken.

Information

Information indicates important information about the product or serves to emphasize a section in the documentation that
deserves special attention from the reader.
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2.6.2 Markup of text elements

Certain elements of the continuous text are distinguished as follows.

Important information Words or expressions with a special meaning
Interpolated position mode Optional: File or product name or other name
Detailed information Internal cross-reference
http://www.samplelink.com External cross-reference

Software and other displays

The following formatting is used to identify the various information content of elements referenced by the software
interface or a drive controller display, as well as any user entries.

Main menu Window names, dialog box names, page names or buttons, combined
Settings proper nouns, functions referenced by the interface
Select Predefined entry

Referencing method A

Save your User-defined entry
<own IP address>

EVENT 52: Displays (status, messages, warnings, faults)
COMMUNICATION

Keyboard shortcuts and command sequences or paths are represented as follows.

[Ctrl], [Ctrl] + [S] Key, shortcut
Table > Insert table Navigation to menus/submenus (path specification)
2.6.3 Mathematics and formulas

The following signs are used to represent mathematical relationships and formulas.

- Subtraction

+ Addition
X Multiplication
+ Division
| Amount

07/2021 | ID 443039.04
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2.7 Trademarks

The following names used in connection with the device, its optional equipment and its accessories are trademarks or
registered trademarks of other companies:

Windows®, Windows’, das Windows'-Logo, Windows® XP, Windows® 7 und Windows’ 10 are
Windows® 7, registered trademarks of Microsoft Corporation in the United States and/or other
Windows" 10 countries.

PROFIBUS’, PROFIBUS” and PROFINET" are registered trademarks of PROFIBUS

PROFINET’ Nutzerorganisation e.V., Karlsruhe, Germany.

SIMATIC, SIMATIC® and TIA Portal’ are registered trademarks of Siemens AG, Munich,

TIA Portal’ Germany.

All other trademarks not listed here are the property of their respective owners.

Products that are registered as trademarks are not specially indicated in this documentation. Existing property rights
(patents, trademarks, protection of utility models) are to be observed.

2.8 Explanation of terms

As relevant standards and products of other manufacturers are referenced, different manufacturer- or standard-specific
names are used for the same term in this documentation.

For improved understandability, the names in this documentation are standardized to STOBER-specific terminology to the
greatest extent possible. The correlation of STOBER-specific names to other sources can be found in the following table.

STOBER PROFINET

Controller 10 controller

Drive controller 10 device

Tab. 1: Correlation of STOBER terminology to PROFINET
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3 General safety instructions

There are risks associated with the product described in this documentation that can be prevented by complying with the
described warning and safety instructions as well as the included technical rules and regulations.

3.1 Directives and standards

The European directives and standards relevant for the product specified in this documentation can be taken from the
directives and standards of the corresponding drive controller.

3.2 Qualified personnel

In order to be able to perform the tasks described in this documentation, the persons instructed to perform them must
have the appropriate professional qualification and be able to assess the risks and residual hazards when handling the
products. For this reason, all work on the products as well as their operation and disposal may be performed only by
professionally qualified personnel.

Qualified personnel are persons who have acquired the authorization to perform these activities either through training to
become a specialist and/or instruction by specialists.

Furthermore, valid regulations, legal requirements, applicable basic rules, this documentation and the safety instructions
included in it must be carefully read, understood and observed.

10
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3.3 Intended use

As defined by EN 50178, drive controllers are electrical devices operating as power electronics to control the flow of energy
in high-voltage systems.

The drive controllers are intended solely for the operation of motors that meet the requirements of EN 60034-1:
= Lean motors of the LM series
= Synchronous servo motors (e.g. of the EZ series)
= Asynchronous motors
= Torque motors
The connection of other electronic loads or operation outside applicable technical specifications constitutes improper use.

When installing drive controllers in machines, commissioning (i.e. commencing intended operation) may not be performed
until it has been determined that the machine is in compliance with local laws and directives. For example, in the European
region, the following applies:

= Machinery Directive 2006/42/EC
= Low Voltage Directive 2014/35/EU

= EMC Directive 2014/30/EU

EMC-compliant installation

The drive controller and accessories must be installed and wired compliant for EMC

Modification

As the user, you may not make any physical, technical or electrical modifications to the drive controller and the accessories.

Maintenance

The drive controller and accessories are maintenance-free. However, take appropriate measures to detect or prevent
possible errors in the connecting wiring.

11
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3.4 Operational environment and operation
The products are subject to sales restrictions in accordance with EN IEC 61800-3.

The products are not designed for use in a public low-voltage network that supplies residential areas. Radio-frequency
interference can be expected if the products are used in this type of network.

The products are intended exclusively for installation in control cabinets with at least protection class IP54.
Always operate the products within the limits specified by the technical data.
The following applications are prohibited:

= Use in potentially explosive atmospheres

= Use in environments with harmful substances as specified by EN 60721, such as oils, acids, gases, vapors, dust and
radiation

Implementation of the following applications is permitted only after approval from STOBER:
= Use in non-stationary applications

= The use of active components (drive controllers, supply modules, energy recovery units or discharge units) from third-
party manufacturers

The products are designed exclusively for operation in TN networks or on wye sources.

The drive controller has a configurable restart. If the drive controller is designed for an automatic restart after energy
shutdown, this must be clearly specified on the system in accordance with EN 61800-5-1.

The drive controller has the option of a Safe Torque Off safety function (STO) in accordance with EN 61800-5-2 for safely
disconnecting the energy supply to the motor. Measures based on this for protection against unexpected startup are
described in EN I1SO 12100 and EN ISO 14118, for example.

3.5 Disposal

Observe the current national and regional regulations when disposing of the packaging and product! Dispose of the
packaging and individual product parts depending on their properties, e.g. as:

= Cardboard

= Electronic waste (circuit boards)
= Plastic

= Sheet metal

= Copper

= Aluminum

= Battery

12
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4 Network structure

A PROFINET network generally consists of a PROFINET segment with a controller (IO controller) and all 10 devices belonging
to this area, i.e. SC6 or SI6 series drive controllers and a PC as the 10 supervisor.

The PS6 supply module, which you also need for SI6 series drive controllers, is not part of the PROFINET network.

The PROFINET network structure is generally tailored to the specific requirements of the respective system. STOBER drive
controllers support a star, line or tree topology.

All PROFINET nodes are integrated into the PROFINET network using internal or external switches (100 Mbps).

You can configure and parameterize the drive controllers using the DriveControlSuite DS6 software from STOBER; Siemens
TIA Portal lets you do this for the entire PROFINET network, for instance.

The following graphic presents an abstract of a PROFINET network using the SI6 series as an example.

o
>
<9
el
= —
©
=
=
o
O
10 supervisor
commissioning
10 controller ]
SIMATIC S7-1500 o
ks
°
1S
o
O
PROFINET
Commissioning
10 devices
1 x supply module, PS6
3 x drive controlleSi6
o
>
<@
o
@
[N

Fig. 1: PROFINET: Network structure, using the SI6 series as an example
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5 Connection

For network connection, PROFINET only allows switches; these in turn allow for flexible network structure and nearly
unlimited network expansion of several kilometers at maximum speed.

5.1 Selecting suitable lines
The PROFINET transmission technology is based on the Fast Ethernet standard.

The connections between the nodes of a PROFINET network generally consist of symmetrical, shielded copper cables
twisted in pairs (shielded twisted pair, CAT 5e quality level). Fiber-optic cables are also a possible means of transmission.

Signals are transmitted according to the 100BASE TX method, i.e. with a transfer rate of 100 Mbps at a frequency of
125 MHz. A maximum of 1440 bytes can be transferred per frame. The maximum cable length is 100 m.

PROFINET cables exist in different versions that are tailored to different application scenarios and ambient conditions.

We recommend using the cables and plug connectors specified in the PROFINET installation guidelines. They are adjusted
for use in automation technology with regard to usage, resistance, EMC properties and color coding.

There are type A, B and C cables, differentiated by installation type:

= TypeA
4-wire shielded copper cable for fixed installation

= TypeB
4-wire shielded copper cable for flexible installation

= TypeC
4-wire shielded copper cable for constant movements

52 X200, X201: Fieldbus connection

In order to be able to connect the drive controllers to other PROFINET nodes, an integrated switch with both X200 and X201
RJ-45 sockets is provided. The sockets are located on top of the device. The associated pin assignment and color coding
correspond to the EIA/TIA-T568B standard.

N T e

112]...1718 1 Communication
2 Tx-
3 Rx+
4 — —
5 — —
6 Rx- Communication
7
8

Tab. 2: X200 and X201 connection description
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6 What you should know before commissioning

The following chapters provide a quick introduction to the structure of the program interface and accompanying window
designations as well as relevant information about parameters and generally saving your project configuration.

6.1 Program interfaces

The following chapters include an overview of the program interfaces for the described software components.

6.1.1 DS6 program interface

Using the graphical interface of the DriveControlSuite commissioning software (DS6), you can project, parameterize and
commission your drive project quickly and efficiently. In case of service, you can evaluate diagnostic information such as
operating states, fault memories and fault counters of your drive project using DriveControlSuite.

Information

The program interface of DriveControlSuite is available in German, English and French. To change the language of the
program interface, select Settings > Language.
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Fig. 2: DS6: Program interface

1 Menu bar Using the File, View, Settings and Window menus, you can open and save projects, display
and hide program windows, select the interface language and access level and change
between different windows in the workspace.

2 Toolbar The toolbar enables quick access to frequently needed functions, like opening and saving
projects and hiding and displaying windows in the program interface.

3 Project tree The project tree forms the structure of your drive project in the form of modules and drive
controllers. Select an element using the project tree first in order to edit it using the
project menu.

4 Project menu The project menu offers you various functions for editing the project, module and drive
controller. The project menu adapts to the element that you selected in the project tree.

5 Workspace The different windows which can be used to edit your drive project, such as the
configuration dialog, wizards, the parameter list or the scope analysis tool, open in the
workspace.

6 Parameter check The parameter check points out irregularities and inconsistencies that were detected in

the plausibility check of calculable parameters.

7 Messages The entries in the messages log the connection and communication status of the drive
controllers, incorrect inputs caught by the system, errors when opening a project or rule
violations in the graphical programming.

8 Variable parameter You can use variable parameter lists to compile any parameters in individual parameter
lists lists for a quick overview.
9 Status bar In the status bar, you can find the specifications of the software version and get additional

information about the project file, the devices and the progress of the process during
processes such as loading projects.
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6.1.1.1 Individualized workspace

The project tree (1) and project menu (2) are connected and, like the parameter check and messages (5, 6), can also be
docked at the left, right or bottom edge of the screen. This program window can also be displayed or hidden using the View
menu.

The workspace (3) and parameter description (4) are also connected to each other and always positioned in the middle.
Both areas can be minimized or maximized.

6.11.2 Navigation using sensitive circuit diagrams
Axis model

LIS Troeof s [0ilser defred, romtonal 7|

1826 Molor exod et | 2: Ndwrwnder -

L.102 Foaition encodar | 0: Moter encodar -

Lmovoversge  [Bimed <)

B A

EiL Rataticnal, brited mavenent

Retatona :
enccdsr by
Motor
— ( & @
Hokngliwts  pgmr  papogrecnder
[ Focd et dts o dsteaE

Fig. 3: DriveControlSuite: Navigation using text links and symbols

In order to illustrate graphically the processing sequence of actual and set values, the use of signals or certain drive
component arrangements and to make configuring the accompanying parameters easier, they are displayed on the
respective wizard pages of the workspace in the form of circuit diagrams.

Blue text links or clickable icons indicate links within the program. These refer to the corresponding wizard pages and, as a
result, allow you to reach additional helpful detail pages with just a click.
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6.1.2 TIA Portal program interface

The Siemens Totally Integrated Automation Portal (TIA Portal) offers a platform you can use to commission your PROFINET
system. The TIA Portal is broken down into the portal view and the project view.

TIA portal view

The TIA overall functionality is broken down into different task areas that you can reach using portals. The following graphic

shows the interface elements of the TIA portal view relevant to this documentation.

3
[t —

@ D OR e

Fig. 4: TIA Portal: Program interface of the portal view

1 Portal selection The portal selection offers you access to various portals for different tasks and functions.
2 Portal functions Depending on the selected portal, the portal functions are available here.
3 Project view The button lets you change to the project view.

18

07/2021 | ID 443039.04



07/2021 | ID 443039.04

STOBER

6 | What you should know before commissioning

TIA project view

The TIA project view offers you access to all components of a project. The following graphic shows the interface elements of

the TIA portal view relevant to this documentation.

Fig. 5: TIA Portal: Program interface of the project view

1
2
3

I

Project navigation
Detail view

Workspace

Inspector window

Task cards

Portal view

Project navigation offers you access to all components of your TIA project.
The detail view shows you additional information about a selected object.

In the workspace, you can edit objects in the topology view, network view or device view,
for example.

The inspector window shows you additional information about a selected object.

Task cards are available depending on the selected object and grant you access to the
hardware catalog, online tools, tasks or libraries, for example.

The button lets you change to the portal view.
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6.2 Meaning of parameters

You can adapt the function of the drive controller to your individual application using parameters. In addition, parameters
visualize the current actual values (actual velocity, actual torque, etc.) and trigger actions like Save values, Test phase, etc.

Interpretation of parameter identification

Parameter identification consists of the following elements, where short forms are also possible, i.e. only specifying a
coordinate or the combination of coordinate and name.

E50| Drive controller | G6 | \[o)
| | |

Coordinate Name Version

Drive controller
generation/series

6.2.1 Parameter groups

Parameters are assigned to individual groups by topic. The 6th generation of STOBER drive controllers differentiates

between the following parameter groups.

A Drive controllers, communication, cycle times

B Motor

C Machine, velocity, torque/force, comparators

D Set value

E Display

F Terminals, analog and digital inputs and outputs, brake
G Technology — Part 1 (application-dependent)

H Encoders

| Motion (all motion settings)

J Motion blocks
K Control panel
L Technology — Part 2 (application-dependent)

Profiles (application-dependent)

Additional functions (application-dependent; extended cam control unit)

Customer-specific parameters (programming)

Customer-specific parameters, instance-dependent (programming)

Production data for the drive controller, motor, brakes, motor adapter, gear unit and geared motor
Safety (safety technology)

Scope

Protection functions

N ¢ 4 v » o ©v =z Z2

Fault counter

Tab. 3: Parameter groups
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6.2.2

In addition to topic-based sorting in individual groups, all parameters belong to a certain data type and parameter type. The

Parameter types and data types

data type of a parameter is displayed in the parameter list, properties table. The connections between parameter types,

data types and their value range can be found in the following table.

INT8 Integer or selection 1 byte (signed)
INT16 Integer 2 bytes (1 word, signed)
INT32 Integer or position 4 bytes (1 double word,
signed)
BOOL Binary number 1 bit (internal:
LSB in 1 byte)
BYTE Binary number 1 byte (unsigned)
WORD Binary number 2 bytes (1 word, unsigned)
DWORD Binary number or parameter 4 bytes (1 double word,
address unsigned)
REAL32 Floating-point number 4 bytes (1 double word,
(single type according to signed)
IEE754)
STR8 Text 8 characters
STR16 Text 16 characters
STR80 Text 80 characters
Tab. 4: Parameters: Data types, styles, possible values

Parameter types: Use

Integer, floating-point number
For general computing processes

Example: Set and actual values

Selection
Numeric value to which a direct meaning is assigned

Example: Sources for signals or set values

Binary number
Bit-oriented parameter information that is collected in binary

Example: Control and status words

Position
Integer combined with associated units and decimal places

Example: Actual and set values of positions

Velocity, acceleration, deceleration, jerk
Floating-point number combined with the associated units and decimal places

Example: Actual and set values for velocity, acceleration, deceleration, jerk

Parameter address
Corresponds to the storage location of another parameter

Example: Indirect read sources for analog and digital outputs and for fieldbus mapping

Text
Outputs or messages

-128 - 127
-32768 — 32767
-2147483648 — 2147483647

0,1
0-255
0-65535

0-4294967295

-3.40282 x 10* - 3.40282 x
1038
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6.2.3 Parameter types

The following types of parameters are differentiated.

Simple parameters Consist of one group and one line with a A21 Brake resistor R: Value = 100 ohms
defined value.

Array parameters Consist of a group, a line and multiple A10 Access level
sequential (listed) elements, which have the

same properties but different values. = A10[0] access level: Value = Access level

via operating unit

= A10[2] access level: Value = Access level
via CANopen and EtherCAT

= A10[4] access level: Value = Access level
via PROFINET

Record parameters Consist of a group, a line and multiple AO0O Save values
sequential (listed) elements, which can have

different properties and different values. * AOO[0] Start: Value = Start action

= AQ0O0[1] Progress: Value = Display action
progress

= A00[2] Result: Value = Display action
result

Tab. 5: Parameter types

6.2.4 Parameter structure

Every parameter has specific coordinates with the following pattern.

1. E200 [0]
T

Line
Group Element
Axis
= Axis
The axis to which a parameter is assigned in the case of multiple axes (optional).

= Group
The thematic group to which a parameter belongs.
= Line
Distinguishes the parameters within a parameter group.

= Element

Elements of an array or record parameter (optional).
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6.2.5 Parameter visibility

The visibility of a parameter depends on the access level defined in the software, the dependency of other parameters, the
selected application and the version of the associated firmware.

Access level

The access options for the individual software parameters are ranked hierarchically and divided into individual levels. This
means that parameters can be hidden for a specific purpose and, relatedly, their configuration options can be locked
starting from a specific level. The following levels are present:

= Level 0

Elementary parameters

= Levell

Important parameters of an application

= Level 2

Important parameters for service with extensive diagnostic options

= Level 3

All parameters needed for commissioning and optimizing an application
Parameter A10 Access level controls general access to parameters:
= Over CANopen or EtherCAT (A10[2])

= Over PROFINET (A10[3])

Hiding functions

Hiding functions are used to hide parameters with regard to their logical relationships to other option modules or
parameters.

Information

It is not possible to write to or read the parameter hidden in DriveControlSuite during communication via fieldbus.

Applications

Applications generally differ in terms of functions and their activation. For this reason, different parameters are available
with each application.

Firmware

A newer version of the firmware may introduce new parameters. Parameters that have been configured for files of an older
firmware function may not be visible in newer versions. In such cases, the respective parameter description includes a
corresponding note.
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6.3 Signal sources and process data mapping

The transmission of control signals and set values in DriveControlSuite meets the following principles.

Signal sources

Drive controllers are either controlled over a fieldbus, using mixed operation consisting of a fieldbus system and terminals
or exclusively using terminals.

You can use the corresponding selection parameters, referred to as data sources, to configure whether the control signals
and set values of the application are obtained over a fieldbus or using terminals.

In case of activation over a fieldbus, parameters that are selected as data sources for control signals or set values must be
part of the subsequent process data mapping; in the case of activation using terminals, the respective analog or digital
inputs are specified directly.

Process data mapping

If you are working with a fieldbus system and have selected the source parameters for control signals and set values,
configure the fieldbus-specific settings, e.g. the layout of process data channels for transmitting receive and transmit
process data, as the last step.

6.4 Power-loss protected storage

All project configurations, parameterizations and related changes to parameter values are in effect after transmission to the
drive controller, but are not yet stored in non-volatile memory.

Saving to a drive controller
You have the following options for saving the configuration to a drive controller in non-volatile memory:

= Saving the configuration using the Save values wizard:
Project menu > Wizards area > Projected axis > Save values wizard: Select the Save values action

= Saving the configuration using the parameter list:
Project menu > Parameter list area > Projected axis > Group A: Drive controller > AOO Save values: Set the parameter
A00[0] to the value 1: Active

Saving to all drive controllers within a project
You have the following options for saving the configuration to multiple drive controllers in non-volatile memory:

= Saving the configuration using the toolbar:
Toolbar > Save values symbol: Click on the Save values symbol

= Saving the configuration using the Online connection window:
Project menu > Online connection area > Projected axis > Online connection window: Click on Save values (A00)

Information

Do not shut off the drive controller while saving. If the supply voltage to the control unit is interrupted while saving, the
drive controller starts without an executable configuration when it is next switched on. In this case, the configuration must
be transferred to the drive controller again and saved in non-volatile memory.
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7 Commissioning

The following chapters describe the commissioning a PROFINET network, consisting of a controller from Siemens and
multiple drive controllers from STOBER, with the help of the STOBER DriveControlSuite and the Siemens TIA Portal.

We put forward the following system environment as an example so that you can better follow the individual
commissioning steps:

= Drive controllers from the SC6 or SI6 series with firmware version 6.5-D-PN or later
= DS6 commissioning software in version 6.5-D or later

in combination with
= Siemens SIMATIC S7-1500 controller

= Siemens Totally Integrated Automation Portal (TIA Portal) V16 automation software

Commissioning is divided into the following steps:

1.  DriveControlSuite:
Project all drive controllers (device control, application, process data, axis model, etc.), parameterize all general
PROFINET settings as well as the PZD transmission, then transmit your configuration to the drive controllers of your
PROFINET network.

2. TIA Portal:
Next, map your actual PROFINET network in TIA Portal and configure the individual nodes. Transfer the configuration

to the controller and start up your PROFINET network.

Information

Before you start commissioning your PROFINET network using DriveControlSuite and TIA Portal, you must network all nodes
of your PROFINET network with each other.
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7. DS6: Configuring the drive controller

Project and configure all drive controllers for your drive system in DriveControlSuite DS6 (see the chapter DS6 program

interface [P 15]).

Information

The steps required for commissioning PROFINET are described based on the drive-based Drive Based application in
combination with Drive Based device control.

The process for mapping your axis model and parameterizing the Drive Based device control or the different operating
modes of the Drive Based application can be found in the accompanying manual (see the chapter Detailed information

[»72)).

Information

Always perform the steps described below in the specified order!

Some parameters are interdependent and do not become accessible to you until you have first configured certain settings.
Follow the steps in the specified sequence so that you can finish the parameterization completely.
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7.1 Initiating the project

In order to be able to configure all drive controllers and axes of your drive system using DriveControlSuite, you must record
them as part of a project.

FANRN Projecting the drive controller and axis

Create a new project and project the first drive controller along with the accompanying axis.

Creating a new project
1. Start DriveControlSuite.

2. Onthe start screen, click Create new project.
= The new project is created and the configuration dialog for the first drive controller opens.

= The Drive controller button is active.

Projecting the drive controller

1. Properties tab:
Establish the relationship between your circuit diagram and the drive controller to be projected in DriveControlSuite.
Reference: Specify the reference code (equipment code) of the drive controller.
Designation: Give the drive controller a unique name.
Version: Version your project configuration.
Description: If necessary, specify additional supporting information, such as the change history of the project

configuration.

2. Drive controller tab:
Select the series and device type of the drive controller.
Firmware: Select the PROFINET version 6.x -PN.

3. Option modules tab:

Safety module: If the drive controller is part of a safety circuit, select the corresponding safety module.

4. Device control tab:
Device control: Select Drive Based.
Rx process data, Tx process data: Select PROFINET Rx and PROFINET Tx for transmitting PROFINET process data.

Information

Make sure that you project the correct series in the Drive controller tab. The projected series cannot be changed
afterwards.
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Projecting the axis

1.

2.

Click on Axis 1.

Properties tab:

Establish the connection between your circuit diagram and the axis to be projected in DriveControlSuite.
Reference: Specify the reference code (equipment code) of the axis.

Designation: Give the axis a unique name.

Version: Version your project configuration.

Description: If necessary, specify additional supporting information, such as the change history of the project

configuration.

Application tab:

Select Drive Based.

Motor tab:
Select the type of motor operated using this axis. If you are working with motors from third-party suppliers, enter the

accompanying motor data at a later time.
Repeat steps 2 — 4 for the 2nd axis (only for double-axis controllers).

Confirm with OK.

711.2 Configuring safety technology

If the drive controller is part of a safety circuit, you must configure the safety technology in accordance with the

commissioning steps outlined in the corresponding manual in the next step.
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71.2 Parameterizing general PROFINET settings

v

1.

You have projected the PROFINET Rx and PROFINET Tx process data for the drive controller.

Highlight the relevant drive controller in the project tree and click on the first projected axis in the project menu >

Wizard area.
Select the PROFINET wizard.

A100 Fieldbus scaling:
Leave the default setting at 1: Native (values are passed unchanged).

A273 PN device name:
Shows the PROFINET device name that was assigned in TIA Portal if there is an online connection between the drive

controller and controller.

A109 PZD-Timeout:
Define the time that results from the tolerated failure time for monitoring the PZD communication plus the watchdog

time of the controller (TIA Portal: response monitoring time) in the PROFINET network (default value: 20 ms).
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71.3 Configuring PZD transmission

The PZD channel (process data transmission channel) serves to transfer control and status information as well as actual and
set values between a controller (10 controller) and drive controller (10 device) cyclically in real time.

The direction of data flow is important in this data exchange. From the perspective of the drive controller, PROFINET 10
distinguishes between receive PZD (RxPZD) and transmit PZD (TxPZD). STOBER drive controllers of the 6th generation
support a flexible assignment of the parameter values to be transmitted.

The RxPZD and TxPZD process data that is exchanged between the controller and drive controller during cyclical data
transmission depends on the projected application. In the PROFIdrive application, the mapping of the process data is
specified by the controller in online operation. In Drive Based applications, the process data is pre-assigned by the standard
mapping accordingly. Check the standard mapping and adjust it if necessary.

You can transfer process data with a maximum of 48 parameters to be transferred over axes A and B (24 per axis).

Information

The PZD processing is WORD-oriented in some controllers (16 bit). In Drive Based applications, the standard mapping is pre-
assigned appropriately. If changes are made to the standard mapping, take the parameter data type that you are adding to
or removing from the mapping into account.

If you add or remove parameters of the BYTE or INT8 data type (8 bit), this can cause problems in the data structures of the
controller. If necessary, use parameter A101 Dummy byte to fill the 8-bit gaps that result in the process data and implement
the necessary data structure for the controller.

71.31 Adapting RxPZD

Information

You define the scope of transmission of cyclical PZD in TIA Portal by projecting a corresponding process data module for
each axis of the drive controller.

v" You have projected the Drive Based application.

1. Highlight the relevant drive controller in the project tree and click on the first projected axis in the project menu >

Wizard area.
2. Select the PROFINET wizard > Received process data RxPZD.

3. Check the standard mapping and adapt it to be transferred to your requirements if necessary.
A90[0] — A90[23], A91[0] — A91[23]:
Target parameters whose values are received by the drive controller from the controller. The position provides

information about the receiving sequence.

4. Resulting data length:
Shows the overall length of the PZD to be transmitted if there is an online connection to the controller. The value

must not exceed the data volume of the process data module that you project in TIA Portal.

! Max. 72 bytes/36 words
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71.3.2 Adapting TxPZD

Information

You define the scope of transmission of cyclical PZD in TIA Portal by projecting a corresponding process data module for
each axis of the drive controller.

v" You have projected the Drive Based application.

1. Highlight the relevant drive controller in the project tree and click on the first projected axis in the project menu >

Wizard area.
2. Select the PROFINET wizard > Transmitted process data TxPZD.

3. Check the standard mapping and adapt it to be transferred to your requirements if necessary.
A94[0] — A94[23], A95[0] — A95[23]:
Source parameters whose values the drive controller sends to the controller. The position provides information about

the transmission sequence.

4. Resulting data length:
Shows the overall length of the PZD to be transmitted if there is an online connection to the controller. The value

must not exceed the data volume of the process data module that you project in TIA Portal.?

2Max. 72 bytes/36 words
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11.4 Mapping the mechanical axis model

To be able to put your real drive train with one or more drive controllers into operation, you must map your complete

mechanical environment in DriveControlSuite.

71.41 Parameterizing the STOBER motor

You have projected one of the following motors:

STOBER synchronous servo motor with EnDat 2.2 digital, EnDat 3 or HIPERFACE DSL encoder (with optional
brake)

By projecting the corresponding motor, limiting values for currents and torques as well as associated temperature data are
automatically transferred to the respective parameters of the individual wizards. All additional data on the brake and

encoder is transferred at the same time.

STOBER Lean motor without encoder (with optional brake)

By projecting the corresponding motor, limiting values for currents and torques as well as associated temperature data are
automatically transferred to the respective parameters of the individual wizards. You only have to parameterize the cable
length in use. Even the brake purging and engaging times are already stored. You just have to activate the brake.

1. Highlight the relevant drive controller in the project tree and click on the first projected axis in the project menu >

Wizard area.
2. Select the Motor wizard.

3. Bl101Cable length:
Select the cable length of the power cable in use.

4. Repeat the steps for the 2nd axis (only for double-axis controllers).
Then activate the brake.

1. Highlight the relevant drive controller in the project tree and click on the first projected axis in the project menu >

Wizard area.
2. Select the Brake wizard.

3. FOO Brake:
Select 1: Active.

4. Repeat the steps for the 2nd axis (only for double-axis controllers).

Motor protection

All models of the 6th STOBER drive controller generation feature a certified it model, a computational model for thermal
monitoring of the motor. In order to activate it and start the protective function, set the parameters as follows (deviating
from the default values): U10 = 2: Warning and U11 = 1.00 s. This model can be used instead of or in addition to
temperature-monitored motor protection.
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71.4.2 Parameterizing the axis model
Parameterize the setup of your drive in this order:
= Define the axis model
= Scale the axis
= Parameterize the position and velocity window
= Limit the axis (optional)
e Limit the position
e Limit the velocity, acceleration and jerk

e Limit the torque and force

Information

If you are using a double-axis controller with two projected axes, you must parameterize the axis model for each axis

individually.
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71.4.2.1 Define the axis model

1.

Highlight the relevant drive controller in the project tree and click on the first projected axis in the project menu >

Wizard area.
Select the Axis model wizard.

105 Type of axis:
Define whether the axis type is rotational or translational.

3.1. If you would like to configure the units of measure and the number of decimal places individually for specifying
and displaying position set values, velocities, accelerations and jerk, select 0: User defined, rotational or 1:

User defined, translational.

3.2. If the units of measure and the number of decimal places for specifying and displaying position set values,

velocities, accelerations and jerk are to be fixed, select 2: Rotational or 3: Translational.

B26 Motor encoder:
Define the interface to which the motor encoder is connected.

102 Position encoder (optional):

Define the interface to which the position encoder is connected.

100 Position range:

Define whether the travel range of the axis is limited or endless (modulo).

If you have selected 1: Endless for 100, parameterize a revolution length (see Scale the axis [P 35]).

Information

If you parameterize 105 Type of axis, you can either use the selections 0: User defined, rotational or 1: User defined,

translational to configure units of measure and the number of decimal places for the axis model individually or use the

selections 2: Rotational and 3: Translational to revert to default values.

Selecting 2: Rotational sets the following units of measure for the axis model: position in °, velocity in rpm, acceleration in

rad/s?, jerk in rad/s.

Selecting 3: Translational sets the following units of measure for the axis model: position in mm, velocity in m/s,

acceleration in m/s?, jerk in m/s®

Information

If you do not parameterize it differently for 102 Position encoder, B26 Motor encoder is used for position control as

standard.
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71.4.2.2 Scale the axis

1. Highlight the relevant drive controller in the project tree and click on the first projected axis in the project menu >

Wizard area.
2. Select the Axis model wizard > Axis: Scaling.

3. Scale the axis by configuring the overall gear ratio between the motor and output.
To simplify this scaling for you, you are provided with the scaling calculator Conversion of position, velocities,

accelerations, torque/force, which calculates the effects of changed movement variables on the entire system.

4. 101 Circular length:
If you have selected 1: Endless for 100 Position range, enter the revolution length.

5. 106 Decimal places position (optional):
If you have selected 0: User defined, rotational or 1: User defined, translational for 105 Type of axis, define the desired
number of decimal places.

6. 109 Measure unit (optional):
If you have selected 0: User defined, rotational or 1: User defined, translational for 105 Type of axis, define the desired

unit of measure.

Information

A change to parameter 106 moves the decimal separator for all axis-specific values!
Ideally, change 106 before parameterizing other axis-specific values and then check them afterwards.

Information

Parameter 1297 Maximum speed position encoder must be parameterized according to your application case. If 1297 is set
too low, the permitted maximum speed is exceeded even at normal operating speeds. On the other hand, if 1297 is set too
high, measuring errors of the encoder can be overlooked.

1297 depends on the following parameters: 105 Type of axis, 106 Decimal places position, 109 Measure unit as well as
107 Distance factor numerator position and 108 Distance factor denominator position for Drive Based or A585 Feed constant
for CiA 402. If you have made changes to one of the parameters listed, select 1297 accordingly as well.

71.4.2.3 Parameterize the position and velocity window

Enter position limits and velocity zones for set values. To do so, parameterize boundary values for reaching a position or
velocity.

1. Select the Axis model wizard > Window position, velocity.

2. C40 Velocity window:

Parameterize a tolerance range for velocity tests.

3. 122 Target window:

Parameterize a tolerance range for position tests.

4. 187 Actual position in window time:
Parameterize how long a drive must stay in the specified position range before a corresponding status message is
output.

5. Parameterize a tolerance range for lag tests.
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71.4.2.4 Limiting the axis

If necessary, limit the movement variables for position, velocity, acceleration, jerk as well as torque/force according to the
applicable conditions for your axis model.

Limiting the position (optional)

1. Highlight the relevant drive controller in the project tree and click on the first projected axis in the project menu >

Wizard area.
2. Select the Axis model wizard > Limit: Position.

3. If necessary, limit the position of your axis using a software or hardware limit switch to secure the travel range.

Limiting velocity, acceleration, jerk (optional)
The specified default values are designed for slow velocities without gear units. For this reason, adapt the saved values.

Note that the velocity of the motor is parameterized in units other than that of the axis model. Verify the velocity of the
motor against the velocity of the output accordingly.

1. Select the Motor wizard.

2. To determine the maximum velocity at the output, copy the value of the B13 Nominal motor speed parameter to the

clipboard.
3. Select the Axis model wizard > Axis: Scaling > Conversion of positions, velocities, accelerations, torque/force area.

4. Velocity line:

Paste the copied value of the B13 parameter from the clipboard without the unit and confirm with ENTER.

= The maximum velocity of the motor has been transferred to the output.
5. Select the Axis model wizard > Limit: Velocity, acceleration, jerk.

6. 110 Maximal speed:

Limit the maximum velocity of the output taking into account the configured Nominal motor speed in B13.

7. Determine the limiting values for acceleration and jerk if necessary and enter them into the associated parameters.

Limiting torque/force (optional)
The specified default values take into account the rated operation together with the overload reserves.
1. Select the Axis model wizard > Limit: Torque/force.

2. If the motor force must be limited, adapt the saved values as necessary.
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71.5 Transmitting and saving the configuration

In order to transmit and save the configuration to one or more drive controllers, you must connect your PC and the drive

controllers over the network.

/A\ WARNING!

Injury to persons and material damage due to axis movement!

If there is an online connection between DriveControlSuite and the drive controller, changes to the configuration can lead

to Unexpected axis movements.

Only change the configuration if you have visual contact with the axis.

Make sure that no people or objects are within the travel range.

Information

During the search, all drive controllers within the broadcast domain are found via IPv4 limited broadcast.

Prerequisites for finding a drive controller in the network:

Network supports IPv4 limited broadcast

All drive controllers are in the same subnet (broadcast domain)

Transmitting the configuration

v

1.

The drive controllers are switched on.

In the project tree, highlight the module under which you have recorded your drive controller and click Online

connection in the project menu.

= The Add connection window opens. All drive controllers found via IPv4 limited broadcast are displayed.

Direct connection tab > IP address column:

Activate the IP addresses in question and confirm your selection with OK.

= The Online connection window opens. All drive controllers connected through the selected IP addresses are
displayed.

Select the drive controller to which you would like to transfer the configuration. Change the selection of transmission
type from Read to Send.

Change the selection Create new drive controller:

Select the configuration that you would like to transfer to the drive controller.
Repeat steps 3 and 4 for all other drive controllers to which you would like to transfer your configuration.

Online tab:

Click on Establish online connections.

The configurations are transferred to the drive controllers.
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Saving the configuration

v" You have successfully transferred the configurations.

1.

Online connection window:
Click on Save values (A00).

= The Save values (A0O0) window opens.
Click on Start action.
= The configurations are saved.

Close the Save values (A00) window.

Online connection window:
Click on Restart (A09).

= The Restart (A09) window opens.
Click on Start action.

Confirm the safety instruction with OK.

= The Restart (A09) window closes.

= The fieldbus communication and connection to DriveControlSuite are interrupted.

= The drive controllers restart.
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71.6 Activating the control panel and testing the configuration

/A WARNING!

Injury to persons and material damage due to axis movement!

By activating the control panel, you have sole control over the movements of the axis using DriveControlSuite. If you are
using a controller, it no longer monitors the axis movements after the control panel is activated. The controller cannot
intervene to prevent collisions. The controller takes over control again when the control panel is deactivated, which can

cause unexpected axis movements.
= Only use the control panel if you have visual contact with the axis.

= Make sure that no people or objects are within the travel range.

v" You have successfully saved the configurations.

v" There must not be any active safety function.

1. Highlight the relevant drive controller in the project tree and click on the first projected axis in the project menu >

Wizard area.
2. Select the Jog control panel wizard.

3. Click Control panel on and then Enable.
= The drive is controlled using the activated control panel.

4. Move the axis step-by-step and test the direction of motion, velocity, distances, etc. using the Jog+, Jog—, Jog step+

and Jog step- buttons.
5. Optimize your project configuration based on your test results as necessary.

6. To deactivate the control panel, click on Control panel off.

Information

Jog+ and Jog- cause a continual manual movement in the positive or negative direction. Jog step+ and Jog step- move the
axis relative to the current actual position by the increment specified in 114.

Jog+ and Jog- have a higher priority than Jog step+ and Jog step-.
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1.2 TIA Portal: Setting up a PROFINET network

A PROFINET networks generally consists of a controller (10 controller) and multiple drive controllers (IO devices). Using
TIA Portal, map your real PROFINET network in a TIA project, configure all PROFINET nodes and link them logically with each
other. Then, transfer the configuration to the controller and check the cyclical communication.

Information
Always perform the steps described below in the specified order!

Some parameters are interdependent and do not become accessible to you until you have first configured certain settings.
Follow the steps in the specified sequence so that you can finish the parameterization completely.

7.2.1 Installing the GSD file

To be able to map the STOBER drive controllers of your PROFINET network in your TIA project, you must import and install a
STOBER-specific GSD file (general station description file) in your TIA project. STOBER drive controllers are available in the
hardware catalog of your TIA project as soon as the GSD file has been installed.

Information

If you have already downloaded a GSD file from the STOBER download area at an earlier point, make sure that you are using
the current version of the GSD file required.

v" You have downloaded the current version of the GSD file from the STOBER download area and saved it locally.

v’ You have created a TIA project and are in the TIA project view.
1. Inthe menu bar, select Options > Manage general station description files (GSD).
= The Manage general station description files window opens.

2. Installed GSDs tab, Source path area:
Select the directory in which you have stored the STOBER-specific GSD file and confirm with OK.

= The GSD file is displayed in the Content of the imported path area.

3. Content of the imported path area:
Select the desired GSD file and click on Install.

= The GSD file is installed; the STOBER drive controllers are available in the hardware catalog.
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1.2.2 Projecting the PROFINET network

Map the controller and all drive controllers of your PROFINET network in a TIA project by selecting the corresponding

modules from the hardware catalog and incorporating them into the project.

7.2.2.1 Projecting the controller

Project the controller of your PROFINET network.

v

v

1.

You have created a TIA project and installed the STOBER-specific GSD.

You are in the TIA network view; the hardware catalog is open.

Hardware catalog:
Select Controller > SIMATIC S7-1500 > CPU and open the folder of the CPU type belong to your controller.

Drag and drop the desired controller into the network view.

The controller is incorporated into your TIA project.

1.2.2.2 Projecting the drive controller

Project all drive controllers of your PROFINET network.

v

v

1.

You have created a TIA project and installed the STOBER-specific GSD.

You are in the TIA network view; the hardware catalog is open.

Hardware catalog:
Select Other field devices > PROFINET 10 > Drives > STOBER ANTRIEBSTECHNIK GmbH & Co. KG > STOBER
ANTRIEBSTECHNIK > STOBER 6th generation drive controllers > SI6, SC6 double-axis controllers/SI6, SC6 single-axis

controllers.
Drag and drop the desired drive controller into the network view.
= The drive controller is incorporated into your TIA project.

Repeat steps 1 and 2 for all drive controllers of your PROFINET network.

7.2.2.3 Linking the controller and drive controller logically

Establish a logical gate link between the controller and drive controllers in order to enable the communication between the

devices.
v" You are in the TIA network view.
v" You have projected the controller and drive controllers.
1. Click on the port of the controller and drag a connection to the port of the first drive controller while holding the
mouse button.
2. Repeat the process for all drive controllers of your PROFINET network.
= The controller and drive controllers of your PROFINET network are linked logically with each other.

Information

To be able to link the controller and drive controllers with each other logically, you must be in the TIA network view.
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1.2.3 Configuring the controller

Configure the network addresses for the controller as needed.

7.2.31 Configuring network addresses

As needed, you can change the IP address and subnet mask of the controller.

v’ You are in the TIA network view.

1. Network view:

Double-click on the controller of your PROFINET network.
= This switches you to the respective device view; the inspector window shows the device properties.

2. General tab:
Select PROFINET interface > Ethernet addresses in the area navigation.

3. IP protocol area > Set IP address in the project:

If it is not active by default, activate this option and change the IP address and subnet mask of the controller.

= The IP address and subnet mask of the controller are configured.
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12.4 Configuring the drive controller

Assign a device name for the drive controllers of your TIA project to be able to identify them in the PROFINET network.

Then, project the process data modules and configure the settings for PZD transmission between the controller and drive

controller.

7.2.4.1 Assigning device names

Assign a device name for your drive controllers to be able to identify them in the PROFINET network.

v

1.

You are in the TIA network view.

Network view:

Double-click on a drive controller of your PROFINET network.
= This switches you to the respective device view; the inspector window shows the device properties.

General tab:

Select General in the area navigation.
= The general settings for the drive controller open.

Name:

Assign a device name for the drive controller that corresponds to the PROFINET naming conventions.

Device view:

Mark the drive controller in question and select Assign device name using its context menu.
= The Assign PROFINET device name window opens.
Click on Update list.

= All drive controllers are listed that were found in the subnet.

= Depending on the drive controller, the device type, IP address and MAC address are displayed.
Mark the drive controller that you would like to name and click on Assign name.

The device name is assigned to the selected drive controller.

Information

Using Flash LED, you can identify which drive controller you have currently selected if multiple drive controllers are found in

the same subnet.

As an alternative, you can identify the drive controller by its MAC address. The MAC address of the drive controller can be
read off in parameter A279 PN MAC addresses in DriveControlSuite (PROFINET wizard > Diagnostics).
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7.2.4.2 Projecting the process data module

Define the data volume for the PZD transmission of the PROFINET communication by projecting a process data module for

each axis.

v" You are in the TIA network view; the hardware catalog is open.

1. Network view:
Double-click on a drive controller of your PROFINET network.
= This switches you to the respective device view; the inspector window shows the device properties.

2. Hardware catalog > Module > Cat 1: Process data modules (PZD), all consistent:
Select a process data module with a data volume that at least corresponds to your process data map in the drive
controller.

3. Dragand drop the selected module into the device overview of the drive controller at slot 1 provided for this.

4. If you are using a double-axis controller, repeat the process for the second axis and slot 2.

= The input and output addresses of the drive controller are generated automatically.
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7.2.4.3 Configuring PZD transmission
For the PZD transmission, configure the cycle time for the data exchange as well as the watchdog time for the monitoring of

PROFINET communication between the controller and drive controller.

v’ You are in the TIA network view.

1. Network view:

Double-click on a drive controller of your PROFINET network.

= This switches you to the respective device view; the inspector window shows the device properties.
2. Inthe area navigation, select PROFINET interface [X1] > Advanced options > Real-time settings > 10 cycle.

= The settings for the 10 cycle open.

3. Update time:

Configure the cycle time in which the controller and drive controller exchange data.

3.1. Calculate update time automatically:

If the cycle time is to be calculated automatically, select this option.

3.2. Set update time manually:

If you want to set the cycle time manually, select this option and specify the desired time.

3.3. Adapt update time when send clock changes:
If you have set the cycle time manually and if the ratio between cycle time and transmission cycle is to remain
constant, also select this option.

4. Watchdog time area:
Configure the watchdog time for monitoring the PROFINET communication.

4.1. Accepted update cycles without 10 data:
Enter the number of permitted cycles after which the PROFINET watchdog is triggered in case of an

interruption in PROFINET communication.

4.2. Watchdog time:
The watchdog time for PROFINET communication is calculated automatically based on the cycle time and the

permitted cycles without data exchange and must not exceed 1.92 seconds.

Information

The application-dependent cycle time of the drive controller can be read off in parameter A150 Cycle time in
DriveControlSuite.
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1.2.5 Transmitting the configuration

Transmit the configuration of your TIA project from your PC to your controller.

v" You have fully mapped and parameterized your PROFINET network in the TIA project.

1.

Project navigation > Devices tab:

Select the folder of the controller in question.
Select Online > Advanced download to device in the menu bar.
= The Advanced download window opens.

Select target device area:

Select Show all compatible nodes and click on Start search.

= All controllers are listed that were found in the subnet.

Select the controller where you would like to transfer the configuration and click on Download.
= The Software synchronization before downloading to a device window opens.

Click on Continue without synchronizing.

= The Preview download window opens.

Click on Download.

= The configuration is transmitted to the selected controller and the Results of the download process window
opens.

Click on Finish.

The download process is complete; the configuration was transmitted successfully to the controller.

Information

If there is an online connection, you can identify which controller you have currently selected using Flash LED if multiple

controllers are located in the same subnet.
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1.2.6 Testing communication

Check the communication between the controller and drive controllers of your PROFINET network using the diagnostics

buffer of the controller.

v

1.

You have transferred the configuration to the controller.

Project navigation > Devices tab:

By double-clicking on Online & diagnostics, open the Online access detail view of the controller in question.
= This switches you to the respective device view.

Online access area:

Click on Connect online.

= An online connection to the selected controller is being established.
In the area navigation, select Diagnostics > Diagnostics buffer.

Results area:

Check the events in the diagnostics buffer for possible errors and correct their causes if necessary.

The connection between the controller and drive controller is projected and a data exchange between the nodes in
the PROFINET network is possible.

Information

If there is an online connection, you can identify which controller you have currently selected using Flash LED if multiple

controllers are located in the same subnet.

Information

Setup of the PROFINET network is complete. As an option, you can continue by programming the acyclical communication

services, as described in Programming acyclical communication services [P 60].
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8 Monitoring and diagnostics

For monitoring purposes and in the event of a fault, the various monitoring and diagnostic options described below are
available.

8.1 Connection monitoring

In order that the drive does not respond in an unwanted manner in the event of an interruption of the PROFINET
connection (cable break, etc.), we recommend monitoring the arrival of cyclical process data.

PROFINET provides the watchdog time (TIA Portal: response monitoring time) for connection monitoring. This time, in
combination with the cycle time (TIA Portal: update time), defines the 10 cycle in the controller (10 controller).

The cycle time determines the interval in which data is transmitted from the controller to the drive controller in question
(10 device) and vice versa. It depends on various factors including the data volume to be transferred and is generally

calculated in TIA Portal automatically for each drive controller.

The watchdog time corresponds to the number of permitted cycles without a data transfer (see the chapter Configuring

PZD transmission [P 45]).

In addition to the watchdog time of the controller, the parameter A109 PZD-Timeout can also be activated in
DriveControlSuite. At the end of the watchdog time projected for the controller, the PZD timeout also takes effect in the

firmware of the drive controller.

Connection interruption

Valid data Old data

Time
»

A

Watchdog time

»
>

A109 PZD-Timeout

Fig. 6: PROFINET: Connection monitoring

The configured watchdog time runs down as soon as an error has occurred, and then the timeout parameterized in A109.
Once the timeout has also elapsed, the drive controller changes to the Fault device state with the accompanying event 52:

communication, cause 4: PZD timeout.
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8.2 LED display

The drive controllers feature diagnostic LEDs that visualize the state of fieldbus communication and the states of the

physical connection.

8.2.1 PROFINET state

There are 2 LEDs on the front of the drive controller that provide information about the connection between controller and
drive controller and about the state of the data exchange. This information can also be read out in parameter A271 PN

state.

N -

Fig. 7: LEDs for the PROFINET state

1 Red: BF (bus error)

2 Green: Run

Off No error

Rapid flashing Data exchange with controller not
active

_ On No network connection

Tab. 6: Meaning of the red LED (BF)

Off No connection

| | | | Flash Connection is set up to controller
Flash, inverse Controller activates DHCP signal service
Flashing Existing connection to controller; data

exchange expected

On Existing connection to controller

fi

Tab. 7: Meaning of the green LED (Run)
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8.2.2 PROFINET network connection

The Act. and Link LEDs at X200 and X201 on the top of the device indicate the state of the PROFINET network connection.

-
1 — =
— _IH
=] o
—] IS
— o X
p— o
2 <
X
3 — £
— R =]
= S
= &
= | =
u— Q
4 <

Fig. 8: LEDs for the state of the PROFINET network connection

1 Green: Link at X201
2 Yellow: Activity at X201
3 Green: Link at X200
4 Yellow: Activity at X200

Off No network connection

_ On Network connection exists

Tab. 8: Meaning of the green LEDs (Link)

Off No data exchange

Flashing Active data exchange with controller

Tab. 9: Meaning of the yellow LEDs (Act.)
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8.3 Events

The drive controller has a self-monitoring system that uses test rules to protect the drive system from damage. Violating
the test rules triggers a corresponding event. There is no possible way for you as the user to intervene in some events, such
as the Short/ground event. In others, you can influence the effects and responses.

Possible effects include:
= Message: Information that can be evaluated by the controller

= Warning: Information that can be evaluated by the controller and becomes a fault after a defined time span has

elapsed without the cause being resolved

= Fault: Immediate drive controller response; the power unit is disabled and axis movement is no longer controlled by
the drive controller or the axis is brought to a standstill by a quick stop or emergency braking

ATTENTION!
Damage to property due to interruption of a quick stop or emergency braking!

If, when executing a quick stop or emergency braking, a fault occurs or STO is active, the quick stop or emergency braking is
interrupted. In this case, the machine can be damaged by the uncontrolled axis movement.

Events, their causes and suitable measures are listed below. If the cause of the error is corrected, you can usually
acknowledge the error immediately. If the drive controller has to be restarted instead, a corresponding note can be found

in the measures.

Information

To make it easier for control programmers to set up the human-machine interface (HMl), a list of events and their causes
can be found in the STOBER download center at http://www.stoeber.de/en/downloads/.
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8.3.1 Event 52: Communication
The drive controller is interrupted if:
= A29 =0: Inactive for Drive Based or PROFIdrive device control

Response:

= The power unit is disabled and axis movement is no longer controlled by the drive controller

= The brakes are applied in the event of an inactive release override (FO6)

The drive controller has a fault and a quick stop occurs if:
= A29 = 1: Active for Drive Based or PROFIdrive device control

Response:

= The axis is stopped by a quick stop; meanwhile, the brakes remain released

= At the end of the quick stop, the power unit is disabled and the axis movement is no longer controlled by the drive

controller; the brakes engage if release override is inactive (FO6)

4: PZD-Timeout Missing process data

14: PZD parameter figure faulty Missing mapping

15: Wrong firmware for Projected fieldbus identification
applicataion and that of the drive controller do
not match

Tab. 10: Event 52 — Causes and actions

Check the cycle time in the controller and
tolerated failure time for monitoring the PZD
communication in the drive controller and
correct if necessary (A109)

Check the mapping for unmappable
parameters and correct them if necessary

Check the projected fieldbus identification and
the fieldbus identification of the drive
controller and change the fieldbus if necessary
(E59[2], E52[3])
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8.4 Parameters

The following diagnostic parameters are available for you in PROFINET communication in combination with SC6 or SI6 series
drive controllers.

8.4.1 A270 | X20x state | G6 | VO

State of the network connection (fieldbus).
= [0]: X200
e O:Error

e 1: No connection
No network cable plugged in

e 2:10 MBit/s
Connection active; transfer rate of 10 Mbps

e 3:100 MBit/s
Connection active; transfer rate of 100 Mbps, half-duplex

e 4:Link OK
Connection active; transfer rate of 100 Mbps, full-duplex

= [1]: X201
See [0]: X200

8.4.2 A271| PN state | G6 | VO
State of the drive controller in the PROFINET network.

= 0: offline
Hardware not ready for use

= l:stepl
Hardware ready for use; no connection to the 10 controller

= 2:step2
IP address received; connection to the 10 controller is set up

= 3:phasel
Drive controller is configured by the 10 controller

= 4:phase 2
Device start-up of 10 controller and drive controller completed; process data communication is started

= 5: cyclic data exchange
Process data communication active

8.4.3 A272 | PN module/submodule | G6 | V1

Module configurations of the drive controller in the PROFINET network (source: IO controller; format: WW XX YYY ZZZ; WW
=module ID, XX = submodule ID, YYY = RxPZD data length in bytes, ZZZ = TxPZD data length in bytes).

= [0]: Single-axis controller, double-axis controller axis A

= [1]: Double-axis controller axis B
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8.4.4 A273 | PN device name | G6 | VO
Device name of the drive controller (I0 device) in the PROFINET network (source: 10 controller).
= [0] — [2]: Current device name; parts 1 — 3 (additional use: DriveControlSuite connection dialog)

= [3] —[5]: Device name after the next fieldbus restart; parts 1 — 3

8.4.5 A274 | PN IP address | G6 | VO
IP address of the drive controller in the PROFINET network (source: 10 controller).
= [0]: Current IP address

= [1]: IP address after the next fieldbus restart

8.4.6 A275 | PN subnet mask | G6 | VO
Subnet mask of the drive controller in the PROFINET network (source: 10 controller).
= [0]: Current subnet mask

= [1]: Subnet mask after the next fieldbus restart

8.4.7 A276 | PN gateway | G6 | VO
Gateway address of the drive controller in the PROFINET network (source: 10 controller).
= [0]: Current gateway address

= [1]: Gateway address after the next fieldbus restart

8.4.8 A279 | PN MAC addresses | G6 | VO
MAC addresses of the drive controller in the PROFINET network.

= [0]: PROFINET device

= [1]: X200

= [2]: X201
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9 More on PROFINET?

The following chapters summarize the key terms, services and relationships relating to PROFINET.

9.1 PROFINET

PROFINET (process field network) is the open industrial Ethernet standard for automation from Siemens, developed in
collaboration with the PROFIBUS-Nutzerorganisation e. V. PROFINET is standardized in IEC 61158 and IEC 61784.

PROFINET is based on Ethernet TCP/IP and is primarily used in cases where fast data communication over Ethernet
networks combined with industrial IT functions are needed.

PROFINET 10

PROFINET 10 was designed in addition to PROFINET CBA as a technological variant for quick data exchange between a
controller and decentralized field devices (decentral peripherals, DP). PROFINET 10 is based on PROFIBUS DP and uses Fast
Ethernet as the means of transmission. Process data (PZD), data for parameterization (parameter channel data), data for
diagnostic purposes, alarms and IT applications are all transferred—over a single network.

PROFINET transmits data with and without a real-time request, while process data and alarms are exclusively transferred
using the real-time communication. PROFINET IO provides two versions in order to scale this optimally:
PROFINET IO-RT for unsynchronized communication and PROFINET IO-IRT for cycle-synchronized real-time communication.

STOBER drive controllers of the 6th generation support PROFINET 10-RT.

PROFINET follows the provider-consumer model where communication partners are on equal footing. Data can be sent
without a request from another network node. Normally, in the case of a data exchange, a controller (IO controller) reads in
the signals from the drive controllers (10 devices), processes them and provides them back to the drive controllers.

9.2 Device classes

PROFINET 1O classifies network nodes into the following device classes based on their tasks.

10 supervisor (PC)

An 10 supervisor is typically a piece of engineering and diagnostics software that can access all process and configuration
data and process alarms or diagnostic messages. The supervisor is normally only integrated into the network on a
temporary basis.

10 controller (controller)

An 10 controller controls data communication, i.e. it receives process data and event-controlled messages and processes
them. A programmable logic controller (PLC, e.g. SIMATIC S7-1500) normally handles the role of the 10 controller.

10 device (drive controller)

An 10 device is typically a decentrally located field device (e.g. a drive controller) that is assigned to at least one 10

controller.

An 10 device transmits process and configuration data as well as alarms. It normally consists of modules that contain the
individual input and output signals of the respective process.
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9.3 Communication

A controller (IO controller) controls and regulates communication with drive controllers (IO devices) in the PROFINET
network. In the process, the controller transmits cyclical process data (PZD), such as control information, to the drive
controllers and receives current status information from them.

In addition, the controller and drive controller acyclically exchange data that is not time-critical, such as configuration
parameter values or one-time events, using parameter channel data.

Both communication services run in parallel, with transmission of cyclical PZD having higher priority. In each cyclical
exchange of data, an acyclical frame is injected as needed.

Information

It is not possible to write to or read the parameter hidden in DriveControlSuite during communication via fieldbus.

9.3.1 Cyclical communication: Process data

Process data (PZD) is normally data that is required for controlling and observing the ongoing process, such as set positions,
travel velocities or acceleration information.

It is generally used for data exchange in real time. It also gives you simultaneous access to multiple drive parameters.
Process data is exchanged quickly and cyclically with a high priority over the RT real-time channel.

For PROFINET IO, the cyclical data traffic relies directly on the MAC address of a device and does not contain any

IP addresses. This keeps the overall length of a data packet relatively small.

The direction of data flow is of critical importance in this data transfer. From the perspective of the respective nodes, a
distinction is made between receive PZD (RxPZD) and transmit PZD (TxPZD).

The specific communication elements that are sent and received in specific PZD can be freely selected. The length and
structure of the process data are defined as part of the project configuration by means of the process data modules (see
the chapter Process data modules [P 71]).

Currently, 48 parameter values with a maximum total length of 72 bytes (36 words) can be exchanged between the 10

controller and |0 device per drive controller.

9.3.2 Acyclical communication: Parameter channel data

Information

If you use the example project provided by STOBER for programming acyclical communication services, this chapter is not
relevant in practice.

The parameter channel is used to transfer data that is not time-critical. Parameter channel data enables read and write
access to the configuration parameters of a drive controller and transfers one-time events.

Parameter channel data is transmitted acyclically in ongoing cyclical PROFINET operation, without impairing PZD
communication. This requires drive-specific acyclical communication services. You can either program them based on the
RDREC and WRREC SIMATIC system function blocks (see the following chapters) or load a STOBER-specific example project
specifically tailored to the STOBER drive controllers of the 6th generation from the STOBER download area in your TIA
Portal and parameterize the parameters appropriately for your system environment.
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9.3.21 RDREC and WRREC: Input and output parameters

In order to transfer acyclical parameter channel data, PROFINET offers the Read record and Write record functions. The
associated interfaces are controlled using the RDREC (read record) and WRREC (write record) SIMANTIC system function
blocks that operate asynchronously.

RDREC and WRREC contain special input and output parameters in a defined sequence. Both blocks communicate with the
10 devices in the network using the input and output parameters described below.

RDREC: Input and output parameters

The RDREC block reads a RECORD out of a hardware component addressed in the ID parameter.

RDREC
—— EN ENO ——
—| rREQ VALID
—{ D BUSY [—
<« | INDEX ERROR |
—| MLEN STATUS [—
Header “Response” Data ‘4—— RECORD LEN |—

Fig. 9: RDREC system function block: Input and output parameters

EN IN

BOOL Release input

REQ BOOL IN Transfer record (REQ = 1: Start transfer)

ID HW_IO IN Hardware identifier for an 10 device; is issued automatically and
can be read out in the device properties (System constants tab),
for example

INDEX DINT IN Record number (the associated value must always be BO2E hex)

MLEN UINT IN Maximum length of the record to be transferred

ENO BOOL ouT Release output

VALID BOOL ouT Record was received and is valid

BUSY BOOL ouT Status of the reading (BUSY = 1: still not finished)

ERROR BOOL ouT Status of the reading (ERROR = 1: faulty)

STATUS DWORD ouT Status of the RDREC block or error information

LEN UINT ouT Length of the record that was read

RECORD Variant IN/OUT Record (consisting of header + data, see the chapter RDREC,

WRREC: RECORD [} 67])

Tab. 11: Parameters of the RDREC system function block
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WRREC: Input and output parameters

The WRREC system function block transfers the RECORD to a hardware component addressed in the ID parameter.

WRREC
— EN ENO ——
—| REQ DONE [
—{ D BUSY
< — INDEX ERROR [
Header “Request” Data ‘t— RECORD STATUS —

Fig. 10: WRREC system function block: Input and output parameters

Crvameen L omatwe —Jommaen |
EN IN

REQ
ID

INDEX
ENO
DONE
BUSY
ERROR
STATUS
RECORD

BOOL
BOOL
HW_IO

DINT
BOOL
BOOL
BOOL
BOOL
DWORD

Variant

IN
IN

IN

ouT
ouT
ouT
ouT
ouT
IN/OUT

Tab. 12: Parameters of the WRREC system function block

Release input
Transfer record (REQ = 1: Start transfer)

Hardware ID for an |10 device; is issued automatically and can be
read out using TIA Hardware Manager > Device > Properties, for
example

Record number (the associated value must always be BO2E hex)
Release output

Status of the communication: Record was transferred

Status of the writing (BUSY = 1: still not finished)

Status of the writing (ERROR = 1: faulty)

Status of the WRREC block or error information

Record (consisting of header + data, see the chapter RDREC,

WRREC: RECORD [P 67])
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9322 RDREC and WRREC: Acyclical communication flow

The following diagrams clarify the communication flow of the RDREC and WRREC system function blocks.

Read record flow

10 controller

1. WRREC [Header Request (Request_ID = 0x01)]

2. RDREC

\ 4

Either
parameter value

e 3. RDREC [Header Response (Response_ID = 0x81) + Data]

3. RDREC [Header Response (Response_ID = 0x01) + Data]

Fig. 11: RDREC flow

Preparation of
parameter value

During RDREC, be aware that each parameter service begins with a read record request and ends with a read record

response.

Write record flow

10 controller

1. WRREC [Header Request (Request_ID = 0x02) + Data ]

2. RDREC |
Either _
- 3. RDREC [Header Response (Response_ID = 0x02) + Data]
s 3. RDREC [Header Response (Response_ID = 0x82) + Data]
error

Fig. 12: WRREC flow

Internal
processing
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933 Programming acyclical communication services
To be able to transfer parameters acyclically, PROFINET provides the Read record and Write record services.

The services are controlled using SIMATIC function blocks RDREC and WRREC. You can either integrate this into the PLC
program yourself or load and parameterize one of the example projects provided for download by STOBER in the TIA Portal.

Information

In the context of the latter, observe the documentation belonging to the example projects.

1. To get the latest project version, switch to the download area on the STOBER website http://www.stoeber.de/en/
downloads/ and enter the term TIA Portal in the search field.

= The TIA Portal Parameter Services (examples for generation 6) project is displayed in the result list.
2. Start the download and save the file to your PC.

3. Unpack the ZIP file.

= The ZIP file contains a ZAP15_1 file (SAT_Param_Example_V15_1500) for the SIMATIC S7-1500 controller from
Siemens.

4. TIA Portal:

Select Project > Retrieve and navigate to the directory where you saved the example project.
5. Open the example project.
= The example project is loaded in the TIA project view.

6. Project tree > Devices tab:

Open the folder of the controller > Program blocks

7. G6_Read_Acyclic and G6_Write_Acyclic function blocks:

Parameterize the blocks as described in the documentation of the example project.

Information

Specifically for double-axis controllers, note that only one acyclic access per device may be active at the same time! When
using the services in combination with internal function blocks, access coordination must be resolved in the application.

In the example project provided by STOBER, the xLockAcyclic bit coordinates simultaneous acyclical access to a drive
controller. The bit locks the communication for other blocks. Every block that acyclically accesses a drive controller locks
access using the xLockAcyclic bit and enables it again by resetting the bit as soon as the data exchange has ended.
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9.4 Communication protocols

PROFINET applications

Standard data RIS
data

Real-time

_ o

Fast Ethernet

Fig. 13: PROFINET communication protocols

One protocol optimized for fast Ethernet is suitable for real-time communication: the real-time protocol.
It allows for a high-performance transfer of cyclical real-time data and event-driven messages.

Standard PROFINET data without a real-time request, such as parameter values or diagnostic data, is usually transferred
using the TCP/IP or UDP/IP protocols. For typical IT applications such as the transfer of websites, e-mails, etc., PROFINET
relies on standard IT protocols such as HTTP or SNMP.

9.5 Service communication via PROFINET

Using PROFINET, it is possible to transport any Ethernet data traffic between nodes in a PROFINET network. This is how
STOBER enables service communication between DriveControlSuite and STOBER SC6 and SI6 drive controllers using the
PROFINET network.

The controller (10 controller) is used as a gateway to the Ethernet network, where the IP address, subnet mask and gateway

of the PROFINET nodes are stored. Ethernet data is transmitted acyclically, i.e. the PROFINET real-time properties (process
data communication) remain unaffected.

There are 2 different topologies for service communication via PROFINET:

= Topology 1
TIA Portal and DriveControlSuite are operated on a PC; only the PROFINET network is used

= Topology 2
TIA Portal and DriveControlSuite are operated on different PCs; transmission takes place between the PROFINET
network and Ethernet

Information

To be able to use the service communication via PROFINET, DriveControlSuite must be connected with the PROFINET
network and be in the same subnet as TIA Portal.

If you assign the IP address to the drive controller in non-volatile memory, DriveControlSuite can find the drive controller
even without the controller.
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9.6 Ethernet network addressing

All PROFINET 10 nodes are based on the Industrial Ethernet Standard, meaning that the assignment of the following
addresses and names is important to be able to communicate with drive controllers in the PROFINET 10 system.

9.6.1 MAC address

Each network interface of a device in an Ethernet network requires its own address —a MAC address. The MAC address is
used as a source and destination address for cyclical data exchange.

A MAC address consists of a fixed and a variable part. The fixed part identifies the manufacturer (3 bytes) and the variable
part distinguishes the individual Ethernet nodes and must be globally unique (also 3 bytes). A MAC address can only
communicate between two nodes of the same subnet.

The MAC addresses of the interfaces are issued by STOBER and cannot be changed.

Information

The MAC address range of the STOBER hardware is: 00:11:39:00:00:00 — 00:11:39:FF:FF:FF

You can read out the MAC address of the PROFINET interface using parameter A279 PN MAC addresses.

9.6.2 IP address
Each PROFINET |0 node has to support various Ethernet-based protocols, at least TCP/IP and UDP/IP.

All data packets sent over the IP protocol contain the respective recipient and sender addresses. Consequently, each
PROFINET node needs a unique IP address to be able to receive communication.

The IP protocol is hardware-independent; unlike the fixed MAC address, the IP address is explicitly assigned to each drive
controller.

The IP address is for acyclical data exchange, e.g. transferring the configuration to the controller, configuring the drive
controllers and reading out device and diagnostic information.

An IPv4 address consists of 4 decimal numbers from the value range 0 — 255 separated by a decimal.

Read out the IP address of a drive controller using parameter A274 PN IP address.

9.6.3 Subnet mask

An IP address always consists of a network ID (for identifying the network) and a host ID (for identifying the node). A subnet
mask defines which parts of the IP address are assigned to the network ID. It has the structure of the IP address but only
marks the network ID.

Read out the subnet mask using the A275 PN subnet mask parameter.
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9.6.4 Subnets and gateways

The IP addresses of a network are usually subdivided into subnets. The purpose of subnets is to provide autonomous
networks with an address range. All PROFINET 10 nodes connected by switches are in a subnet, meaning that they
communicate over a direct path. All nodes of a subnet have the same subnet mask.

Gateways are components of a subnet and are responsible for forwarding subnet-specific network queries to other
subnets.

Information

Be aware that real-time communication is only possible within a subnet due to addressing with MAC addresses. It is not
possible to use routers for real-time communication via PROFINET.

9.6.5 MAC and IP addressing using device names

To be able to provide unique identification of a drive controller (10 device) in a PROFINET IO system, it must have a symbolic
device name that is unique in the system. It is assigned during the project planning phase in TIA Portal and then transferred
to the drive controllers. The device name is used for parameterizing the individual drive controllers during system start-up
and assigning the respective MAC and IP addresses, the latter using DCP or DHCP.

Observe the following conventions when specifying device names:

= The device name must be limited to a maximum of 240 characters.
Letters, numbers, periods and dashes are permitted.

= A name component, i.e. a character string between 2 periods, may be a maximum of 63 characters long.
= Special characters like umlauts, brackets, question marks, slashes, spaces, etc. are not allowed.

= The device name may not begin with numbers.

= The device name may neither begin nor end with a minus sign (=) or a period (.).

= The device name may not take the form n.n.n.n (n =0 —999).

= The device name may not begin with the character sequence port-xyz- (x,y,z=0-9).

= Underscores (_) are not allowed.

9.7 Cycle times

Possible cycle times can be found in the following table.

PROFINET fieldbus, cyclical 1ms,2ms,4ms, 8 ms Adjustable in A150
communication

Tab. 13: Cycle times
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10 Appendix

10.1 Standard mapping of PROFINET and Drive Based

Information

The PZD processing is WORD-oriented in some controllers (16 bit). In Drive Based applications, the standard mapping is pre-
assigned appropriately. If changes are made to the standard mapping, take the parameter data type that you are adding to
or removing from the mapping into account.

If you add or remove parameters of the BYTE or INT8 data type (8 bit), this can cause problems in the data structures of the
controller. If necessary, use parameter A101 Dummy byte to fill the 8-bit gaps that result in the process data and implement
the necessary data structure for the controller.

10.1.1 SC6, S16: RxPZD

The following tables shows the PROFINET standard RxPZD mapping of the Drive Based and Drive Based synchronous
applications. The mapping is defined in parameter array A90 for axis A and in A91 for axis B and can be adapted individually.

BYTE Control byte device 1.A180
1 BYTE Control byte command 1.J37
2-3 WORD Control word application 1.1210
4 SINT Command 1.J40
5 SINT Motion-ID 1.J41
6-9 DINT Position 1142
10-13 REAL Velocity 1 1.J43
14-17 REAL Velocity Override 1.J56
18-21 REAL Torque/Force reference 1.G469
22 BYTE Control byte motion block 1.J01
23-24 INT Reference motion block 1.J02

Tab. 14: SC6, SI6: PROFINET standard RxPZD mapping; first part, axis A

BYTE Control byte device 2.A180
1 BYTE Control byte command 2.J37
2-3 WORD Control word application 2.1210
4 SINT Command 2.J40
5 SINT Motion-ID 2.J41
6-9 DINT Position 2142
10-13 REAL Velocity 1 2.)43
14-17 REAL Velocity Override 2.J56
18-21 REAL Torque/Force reference 2.G469
22 BYTE Control byte motion block 2.J01
23-24 INT Reference motion block 2.J02

Tab. 15: SC6, SI6: PROFINET standard RxPZD mapping; second part, axis B
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10.1.2

SC6, S16: TxPZD

The following tables show the PROFINET standard TxPZD mapping of the Drive Based and Drive Based synchronous

applications. The mapping is defined in parameter array A94 for axis A and in A95 for axis B and can be adapted individually.

8-11
12-15
16-19
20-21
22

23
24-25
26

Tab. 16: SC6, SI6: PROFINET standard TxPZD mapping; first part, axis A

BYTE
BYTE
WORD
BYTE
BYTE
WORD
DINT
REAL
REAL
WORD
SINT
BYTE
INT
SINT

Status byte device
Status byte device
Status word 2

Status byte application
Status byte command
Status word application
Current position

Actual speed

Actual torque/force
Status word user-defined
Operating condition
Status byte motion block
Actual motion block

Device control state

1.E200(0]
1.E200[1]
1.E201
1.1212
1.139
1.1200
1.180
1.188
1.E90
1.A67
1.E80
1.J302
1.J300
1.E48

8-11
12-15
16-19
20-21
22

23

24 -25
26

Tab. 17: SC6, SI6: PROFINET standard TxPZD mapping; second part, axis B

BYTE
BYTE
WORD
BYTE
BYTE
WORD
DINT
REAL
REAL
WORD
SINT
BYTE
INT
SINT

Status byte device
Status byte device
Status word 2

Status byte application
Status byte command
Status word application
Current position

Actual speed

Actual torque/force
Status word user-defined
Operating condition
Status byte motion block
Actual motion block

Device control state

2.E200[0]
2.E200[1]
2.E201
2.1212
2.J39
2.1200
2.180
2.188
2.E90
2.A67
2.E80
2.J302
2.J300
2.E48
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10.2 Addressing parameters for RECORD record

To be able to address a parameter via fieldbus, you need its Axis_number, Parameter_number and subindex. These are
calculated from the STOBER parameter coordinates (axis, group, line, element).

Basic information on the parameters can be found in the chapter Meaning of parameters [P 20].

10.2.1 Determining the Axis_number

The Axis_number corresponds to the axis of the parameter.

10.2.2 Calculating the Parameter_number

Information

Note that the Parameter_number in the RECORD record must be specified in hexadecimal form.

The Parameter_number is calculated from the group and line of the parameter according to the following formula:
Parameter_number decimal = 8192 + (number of the group x 512) + number of the line

Calculation example for parameter E200 (number of the group =4,
number of the line = 200):
Parameter_number E200 = 8192 + (4 x 512) + 200 = 10440 = 28C8 hex

A: Drive controller 0 AO0 - A511
B: Motor 1 BOO - B511
C: Machine 2 C00-C511
D: Target value 3 D00 - D511
E: Display 4 EO0 - ES511
F: Terminals 5 FOO—-F511
G: Technology 6 G00 - G511
H: Encoder 7 HOO — H511
I: Motion 8 100-1511

J: Motion blocks 9 J00-J511
K: Control panel 10 KOO - K511
M: Profile 12 MO0 - M511
P: Customer-specific parameters 15 POO - P511
Q: Customer-specific parameters, 16 Q00-Q511
instance-dependent

R: Production data 17 ROO - R511
S: Safety 18 S00 —-S511
T: Scope 19 TOO-T511
U: Safety functions 20 u0oo - U511
Z: Fault counter 25 Z00-27511

Tab. 18: Groups and parameters

10.2.3 Determining the subindex

The subindex corresponds to the element of the array or record parameter. The subindex of simple parameters is 0.
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10.3

10.3.1

RDREC, WRREC: RECORD

WRREC: RECORD request: Header structure

Parameter values are generally transferred using the RECORD header. For a RECORD request, the header consists of the

following elements in the specified sequence.

Request_reference BYTE
Request_ID BYTE
Axis_number BYTE
Number_of_parameters BYTE
Attributes BYTE
Number_of_elements BYTE
Parameter_number WORD
Subindex WORD
Format BYTE
(Condition: Request_ID = 2 hex)
Number_of values BYTE
(Condition: Request_ID = 2 hex)

1st value DINT
(Condition: Request_ID = 2 hex)

2nd value — 50th value DINT

(Condition: Request_ID = 2 hex)

Tab. 19: WRREC: RECORD request: Header structure

0 hex — FF hex
1 hex

2 hex

All other values
0-3

1

All other values
10 hex

80 hex

81 hex

82 hex

1-32 hex
2000 hex — 5FFF hex
0 —3E80 hex

8 hex

41 hex
42 hex
43 hex

1C hex, 1D hex, 1E
hex

1-50

1st parameter value

1-32 hex

Freely selectable request number

Read request

Write request

Reserved

Addressing the axis

Number of parameters to be processed
Reserved

Access type: Value

Access type: Raw value

Access type: Integer

Access type: Floating point

1-50 Parameters are to be written or read
Group and line of a parameter

Element of an array and record parameter;
in single parameters, the value =0

Transfer format: FLOAT
Transfer format: BYTE
Transfer format: WORD
Transfer format: DWORD

Transfer format: STRING with 8, 16 or 80
characters

Number of values to be processed;

value = 1 (in a simple parameter) or value =
value of Number_of_elements;

since a RECORD request may not exceed a
length of 240 bytes, it is not always possible
— depending on the respective format —

to transfer max. 50 elements

Value in a simple parameter

Value = Value of Number_of_elements
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10.3.2

RDREC: RECORD response: Header structure

Parameter values are generally transferred using the RECORD header. For a RECORD response, the header consists of the

following elements in the specified sequence.

Response_reference

Response_ID

Axis_number
Number_of parameters

Format

Number_of_values

1st value or
error code

2nd value — 50th value

BYTE

BYTE

BYTE
BYTE
BYTE

BYTE
DINT
WORD

DINT

0 hex — FF hex

1 hex
2 hex
81 hex
82 hex
0-3
1

8 hex
41 hex
42 hex
43 hex
1C hex, 1D hex, 1E hex

44 hex
1

1st parameter value

1-32 hex

Tab. 20: RDREC: RECORD response: Header structure

Value = Request number of RECORD
request

Positive answer to a read request
Positive answer to a write request
Negative answer to a read request
Negative answer to a write request
Addressing the axis

Number of parameters to be processed
Transfer format: FLOAT

Transfer format: BYTE

Transfer format: WORD

Transfer format: DWORD

Transfer format: STRING with 8, 16 or 80
characters

Error in case of error
Number of values to be processed
Value in a simple parameter

Error code in case of error (see table
RDREC, WRREC: Error codes [» 69])

Value = Value of Number_of_elements
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10.3.3

RDREC, WRREC: Error codes

The following table shows the possible error codes for the RDREC and WRREC system function blocks.

Error code Cause

0 hex
1 hex
2 hex
3 hex
B hex
11 hex
14 hex

16 hex

17 hex
18 hex
21 hex
A5 hex
BO hex
B2 hex
B3 hex
B9 hex
BA hex
CO hex
C1 hex

Parameter unfamiliar or configuration stopped

Access to read-only parameter

Access to parameter with value outside the limit

Access to unavailable subindex (array parameter)

User level not reached

Parameter may not be changed in the current device state; deactivate release

Invalid value within maximum limits; only occurs in the case of selection parameters with a broken
definition range

One or more incorrect values in the attribute, Number_of_elements, Parameter_number and subindex
elements

Invalid format specification

Contrary value in the Number_of_elements and Number_of_values elements

Invalid Request_ID = Service not supported; applies to errors in the header of the request block
Error cannot be specified in more detail

Parameter service currently not possible or valid parameter description not present

Unfamiliar parameter address (parameter or element does not exist)

Read/write access not possible for specified parameter address

Parameter service: Value in definition gap (observe ENUM list)

Parameter service: Clash with other values

Parameter service: Error in pre-read function

Parameter service: Error in post-write function; value has already been received

Tab. 21: RDREC, WRREC: Error codes
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10.3.4

Attribute and format elements: Possible combinations

The attribute element describes the access to a parameter structure (e.g. to values, descriptive texts, etc.); the format

element describes the transfer format of a parameter. The values of both elements can be combined as follows.

BYTE
(41 hex)

Format

WORD
(42 hex)

FLOAT
(8 hex)

Value Not permitted

(10 hex)

Raw value Unscaled raw

(80 hex) value, specifically
for FLOAT data
type (4 bytes)

Integer Not permitted

(81 hex)

Scaled
representation for
all parameters as
floating point

(4 bytes)

Floating point
(82 hex)

Not permitted

Unscaled raw
value, specifically
for BOOL, WORD,
I8 data types

(1 byte)

Not permitted

Not permitted

Tab. 22: Attribute, format: Possible combinations

Not permitted

Unscaled raw
value, specifically
for WORD, 116 data
types

(2 bytes)

Not permitted

Not permitted

DWORD STRING

(43 hex) (1C hex, 1D hex,
1E hex)

Scaled value for all 8, 16 or 80

parameters characters

represented as
integer (4 bytes)

Unscaled raw
value, specifically
for DWORD, 132
data types

(4 bytes)

Not permitted

Scaled value for all
parameters
represented as
integer (4 bytes)

Not permitted

Not permitted Not permitted
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10.4 Process data modules

Process data modules determine the data volume for the PZD transmission. During configuration in TIA Portal, one of the

following process data modules must be configured for each axis of the drive controller. When creating a new project, we

recommend the all consistent transfer type.

M101 02W PZD
all cons.

M102 04W PZD
all cons.

M103 06W PZD
all cons.

M104 12W PZD
all cons.

M105 18W PZD
all cons.

M106 24W PZD
all cons.

M107 36W PZD
all cons.

M111 02W PZD
Item cons.

M112 04W PZD
Item cons.

M113 06W PZD
Item cons.

M114 12W PZD
Item cons.

M115 18W PZD
Item cons.

M116 24W PZD
Item cons.

M117 36W PZD
Item cons.

12

24

36

48

72

12

24

36

48

72

Tab. 23: Process data modules

*) all consistent:

**) Items consistent:

12

24

36

48

72

12

24

36

48

72

2 words (inputs, outputs),
all consistent*

4 words (inputs, outputs),
all consistent

6 words (inputs, outputs),
all consistent

12 words (inputs, outputs),
all consistent

18 words (inputs, outputs),
all consistent

24 words (inputs, outputs),
all consistent

36 words (inputs, outputs),
all consistent

2 words (inputs, outputs),
Items consistent**

4 words (inputs, outputs),
Items consistent

6 words (inputs, outputs),
Items consistent

12 words (inputs, outputs),
Items consistent

18 words (inputs, outputs),
Items consistent

24 words (inputs, outputs),
Items consistent

36 words (inputs, outputs),
Items consistent

Process data packet is processed once the packet has been fully received

Individual parameters of the packet are processed once the parameter has been fully

received
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10.5 Detailed information

The documentation listed in the following table offers additional relevant information about the associated drive
controllers.

Current document versions can be found at http://www.stoeber.de/en/downloads/.

SC6 drive controller Manual System design, technical data, project 442790
configuration, storage, installation, connection,
commissioning, operation, service, diagnostics

Multi-axis drive system with SI6 Manual System design, technical data, project 442728
and PS6 configuration, storage, installation, connection,
commissioning, operation, service, diagnostics

Drive Based (DB) application Manual Project planning, configuration, parameterization, 442706
function test, detailed information

PROFIdrive application — SC6, SI6 Manual Project planning, configuration, parameterization, 443270
function test, detailed information

Additional information and sources that form the basis of this documentation or are referenced by the documentation:

Information concerning PROFINET

You can find general information on PROFINET on the PROFIBUS & PROFINET International (PI) website at
http://www.profibus.com. PROFINET-specific guidelines, profiles, presentations, brochures and software are available in

the corresponding download area.

Information concerning the Siemens TIA Portal

The most important information about the Siemens TIA Portal and additional documents, links and training courses can be
found at
http://www.industry.siemens.com/topics/global/en/tia-portal/pages/default.aspx.

SC6, SI6 — Device description

A GSD file for easily integrating the drive controllers of the SC6 and SI6 series into the respective system environment can
be found in the STOBER download center http://www.stoeber.de/en/downloads/ using the search term GSD.

STOBER TIA Portal example projects — Programming acyclical communication services

STOBER-specific example projects along with the accompanying documentation for programming acyclical communication
services in TIA Portal can be found in the STOBER download center http://www.stoeber.de/en/downloads/ using the search
term TIA Portal.
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10.6

Abbreviations

BF
CBA
CPU
DCP
DHCP
DP
EMC
GSD
GSDML
HMI
HTTP
IEC
IEEE
1/0

IRT

LAN

LSB

MAC

PG
PROFIBUS
PROFINET
PZD
RDREC

RT

RxPZD
SNMP
PLC

TIA

TCP
TxPZD
ubp
WRREC

Busfehler (en: Bus error)

Component Based Automation
Central Processing Unit

Discovery and Configuration Protocol
Dynamic Host Configuration Protocol
Decentral peripherals
Electromagnetic Compatibility

General Station Description data

General Station Description Markup Language

Human Machine Interface

Hypertext Transfer Protocol

International Electrotechnical Commission

Institute of Electrical and Electronics Engineers

Input/Output

Internet Protocol
Isochronous Real-Time
Local Area Network
Least Significant Bit

Media Access Control

Programmiergerat (en: Programming device)

Process Field Bus

Process Field Network

Process Data

Read Record

Real-Time

Receive PZD (receive process data)
Simple Network Management Protocol
Programmable Logic Controller
Totally Integrated Automation
Transmission Control Protocol
Transmit PZD (transmit process data)
User Data Protocol

Write Record
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1.1 Consultation, service and address
We would be happy to help you!

We offer a wealth of information and services to go with our products on our website:
http://www.stoeber.de/en/service

For additional or personalized information, contact our consultation and support service:

http://www.stoeber.de/en/support

Do you need our first-level support?:
Phone +49 7231 582-3060
applications@stoeber.de

Do you need a replacement device?:
Phone +49 7231 582-1128
replace@stoeber.de

Call our 24-hour service hotline:
Phone +49 7231 582-3000

Our address:

STOBER Antriebstechnik GmbH + Co. KG
Kieselbronner Strasse 12

75177 Pforzheim, Germany

1.2 Your opinion is important to us

We created this documentation to the best of our knowledge with the goal of helping you build and expand your expertise

productively and efficiently with our products.

Your suggestions, opinions, wishes and constructive criticism help us to ensure and further develop the quality of our

documentation.

If you want to contact us for a specific reason, we would be happy to receive an e-mail from you at:

documentation@stoeber.de

Thank you for your interest.
Your STOBER editorial team
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11.3 Close to customers around the world

We offer you committed, expert advise and support in over 40 countries worldwide:

STOBER AUSTRIA
www.stoeber.at

Phone +43 7613 7600-0
sales@stoeber.at

STOBER CHINA
www.stoeber.cn

Phone +86 512 5320 8850
sales@stoeber.cn

STOBER FRANCE
www.stober.fr

Phone +33 4 78.98.91.80
sales@stober.fr

STOBER ITALY
www.stober.it

Phone +39 02 93909570
sales@stober.it

STOBER JAPAN
www.stober.co.jp
Phone +81 3 5875 7583
sales@stober.co.jp

STOBER USA
www.stober.com
Phone +1 606 759 5090
sales@stober.com

STOBER SOUTH EAST ASIA
www.stober.sg
sales@stober.sg

STOBER SWITZERLAND
www.stoeber.ch

Phone +41 56 496 96 50
sales@stoeber.ch

STOBER TAIWAN
www.stober.tw

Phone +886 4 2358 6089
sales@stober.tw

STOBER TURKEY
www.stober.com
Phone +90 216 510 2290
sales-turkey@stober.com

STOBER UNITED KINGDOM
www.stober.co.uk

Phone +44 1543 458 858
sales@stober.co.uk

75



Glossary STOBER

Glossary

100Base-TX

Ethernet network standard based on symmetrical copper cables in which the nodes are connected to a switch via
copper cables twisted in pairs (shielded twisted pair, CAT 5e quality level). 100Base-TX is the subsequent progression
from 10Base-T and includes those properties with the option of a transfer speed of 100 Mbps (Fast Ethernet).

Broadcast domain

Logical grouping of network devices within a local network that reaches all nodes via broadcast.

GSD file

Includes the technical features of a PROFINET IO device (type, configuration data, parameters, diagnostic information,
etc.) in XML format in accordance with the GSDML specification. A GSD file serves as the configuration basis for project

configuration systems and is generally provided by the respective device manufacturer.

IO controller

Generally, a programmable logic controller that controls automation tasks and regulates data communication.

|0 device

A decentralized field device that is assigned logically to a PROFINET |0 controller that manages and controls it.

An 10 device consists of multiple modules and submodules.

10 supervisor

Generally, engineering software that can access all process and configuration data. An 10 supervisor is only engaged

temporarily for parameterizing the 10 devices, commissioning the |0 system and for diagnostic purposes.

IPv4 limited broadcast

Type of broadcast in a network with IPv4 (Internet Protocol version 4). The IP address 255.255.255.255 is entered as
the destination. The content of the broadcast is not forwarded by a router, which limits it to the local network.

MAC address

Also: Ethernet address. Hardware address for unique identification of a device in an Ethernet network.

The MAC address is assigned by the manufacturer and consists of a 3-byte manufacturer ID and 3-byte device ID.

PROFINET

Open Ethernet standard of PROFIBUS Nutzerorganisation e. V. (PNO) for automation.

PZD

Control and status information that is time-critical and transmitted in the PROFINET network cyclically using telegrams.
Depending on the view of the respective node, a distinction is made between receive PZD (RxPZD) and transmit PZD
(TxPZD).
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RxPZD

Output data that a node receives with RxPZDs.

System function block (Siemens)

Code block as part of a distributed, structured Siemens user program used to call up important system functions for
PROFINET 10. Parameters for the associated input and output interfaces can be configured individually. The variable
values stored in a function block are saved and are not lost after processing. Typical Siemens system function blocks
are WRREC (Write record) and RDREC (Read record).

TCP/IP

Protocol family composed of the transmission control protocol (TCP) and the Internet protocol (IP). TCP is responsible

for transmission, i.e. actual data traffic; IP handles unique communication with a PC in a network.

TxPZD

Input data that a node transmits with TxPZDs.

UDP/IP

Minimalist transport protocol for networks such as LAN that only provides the essential functions for data transport.
UDP/IP is a simple service that functions without a continuous connection on both sides. There is no connection or
disconnection and no acknowledgment of the received data packets. There is the option to control data traffic using a
checksum. As with TCP/IP, there are no troubleshooting mechanisms. Therefore, it is entirely possible for the

transferred data to experience data loss, data duplication or sequence errors.
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